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Job No: 13 Duration: 16H
Job Title: Create Basic Animation
Objective:

To understand the basic concepts behind animation are derived from the traditional “cartoon”
animation techniques where a master animation sketches objects at key points in time and then
passes those sketches to the junior animators whose job is to draw all the “in-between” positions
that transition from one pose to the next.

Students should be able to understand the usage of the following:

e Basic Animation concept
e Use Auto Key mode

e Use Set Key mode

e Path Constraint

e Track View

Introduction:

With 3ds Max, you can create 3D computer animation for a variety of applications. You can
animate characters and vehicles for computer games and produce special effects for film and
broadcast. Additional applications include medical illustration and forensic presentation in the
courtroom.

The basic method for creating animation in 3ds Max is quite simple. First you turn on the Auto
Key button, then you move the time slider, and last you transform an object to change its
position, rotation, or scale over time.

You can employ animation throughout 3ds Max. You can animate the position, rotation, and
scale of an object, and almost any parameter setting that affects an object's shape and surface.
You can link objects for hierarchical animation, using both forward and inverse kinematics, and
you can edit your animation in Track View.
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Animation Concept:

Animation is based on a principle of human sight called persistence of vision. If you view a
series of related still images in quick succession, you perceive them as continuous motion. Each
individual image is referred to as a frame, and the illusion of motion comes from the fact that
your visual system retains each frame for a short time after you see it.

ot

A frame is a single image in an animated film.
Traditional Animation Method:

Historically, the main difficulty in creating animation has been the effort required of the
animator to produce a large number of frames. One minute of animation might require between
720 and 1800 separate images, depending on the quality of the animation. Creating images by
hand is a big job. That’s where the technique of keyframing comes in.

Most of the frames in an animation are routine, incremental changes from the previous frame
directed toward some goal. Traditional animation studios realized they could increase the
productivity of their master artists by having them draw only the important frames,

called keyframes. Assistants could then figure out what belonged on the frames in between the
keyframes. The in-between frames were called tweens.

Once all of the keyframes and tweens were drawn, the images had to be inked or rendered to
produce the final images. Even today, production of a traditional animation usually requires
hundreds of artists to generate the thousands of images needed.
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The frames marked 1, 2 and 3 are key frames. The other frames are tweens.
3D Max Animation Method:

This program is your animation assistant. As the master animator, you create the keyframes that
record the beginning and end of each animated sequence. The values at these keyframes are
called keys. 3ds Max calculates the interpolated values between each pair of keys to produce the
completed animation.

3ds Max can animate just about any parameter in your scene. You can animate modifier
parameters, such as a Bend angle or a Taper amount, material parameters, such as the color or
transparency of an object, and much more.

Once you have specified your animation parameters, the renderer takes over the job of shading
and rendering each frame. The result is a high-quality animation.
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The object’s position at 1 and 2 are the keyframed models at different times. The computer
generates the in-between frames.

Comparing Frames and Time:

Traditional animation methods, and early computer animation programs, are rigidly locked to the
concept of producing animation frame by frame. This is okay if you always work in a single
format or do not need to specify an animated effect at a precise time.

Unfortunately, animation comes in many formats. Two of the more common formats are film at
24 frames per second (FPS) and NTSC video at 30 FPS. Also, the need for accurate time-based
animation versus frame-based animation is critical as animation becomes more common for
scientific and legal presentation.
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Different animation formats have differing frame rates.

3ds Max is a time-based animation program. It measures time, and stores your animation values,
with an internal precision of 1/4800 of a second. You can configure 3ds Max to display time in a
format best suited for your work, including traditional frames format. See Time Configuration .

Using Auto Key Mode:

To start creating animation, first turn on the Auto Key button, use the time slider to go to a
particular frame, and then change something in your scene. You can animate the position,
rotation, and scale of an object, and almost all other settings and parameters.

When you make a change, 3ds Max creates a key storing the new value for the changed
parameter at the current time. If that key is the first animation key created for the parameter, a
second animation key is also created at the Auto Key default frame to hold the parameter’s
original value.

Keys are not created at the default frame until you create at least one key at a subsequent frame.
After that, you can move, delete, and re-create keys at the default frame.
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Turning on Auto Key has the following effects:

e The Auto Key button, the time slider, and the border of the active viewport turn red to
indicate you are in animation mode.

« When you transform an object or change an animatable parameter, 3ds Max creates keys at
the current frame, as indicated by the time slider position.

To see an example of using Auto Key to create animation, play the following video:
>Using Auto key mode

To begin animating an object:

1. Click ESS8Sd (Auto Key) to turn it on.
2. Drag the time slider to a different time.
3. Do one of the following:

e Transform an object.

e Change an animatable parameter.

For example, if you have a cylinder that has not been animated yet, it has no keys. If you turn on
Auto Key, and at frame 20 you rotate the cylinder 90 degrees about its Y axis, rotation keys are
created at frames 0 and 20. The key at frame 0 stores the original orientation of the cylinder,
while the key at frame 20 stores the animated orientation of 90 degrees. When you play the
animation, the cylinder rotates 90 degrees about its Y axis over 21 frames.

Using the Set key

The Set Key animation method is for the professional character animator who wants be able to
try out poses and then commit those poses to keyframes intentionally. Animators can also use it
to set keys on specific tracks of objects.

The Set Key method allows more control than the Auto Key method, because it gives you the
chance to try out ideas and discard them quickly without having to undo work. It lets you
transform objects and selectively key certain tracks on certain objects through the use of Key
Filters and Keyable tracks in Track View.
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To use Set Key animation:

1. Click ES& to turn it on.

sadiatll The button turns red to show you are now in Set Key mode. In this mode, you can try
out ideas before you commit to them.

2. Open Track View (either Curve Editor or Dope Sheet).

3. Onthe Track View toolbar, click (Show Keyable).

4. Turn off all the tracks you don't want to keyframe.

o= The red key means the track will be keyed. If you click the red key, it turns to a gray key,
which means that track will not be keyed.

TipYou can toggle multiple tracks as keyable by using the Edit menu » Controller
submenu » Keyable command.

When you are finished, minimize or close Track View.

5. Click BESEEEESIN and use the Set Key Filters dialog to enable the tracks you want
keyframed.

Position, Rotation, and Scale are on by default. So is IK Parameters.

You can use Key Filters to work on individual tracks selectively. For example, if you are in
Track View and the Rotation and Position tracks of a character's arm are keyable, you can
use the key filters to turn off the Position filter and only work on the Rotation tracks.

6. Move the time slider to another point in time, transform your objects or adjust parameters in
the command panels to create animation.

This does not yet create keyframes.

7. Click . (Set Keys) or press K on the keyboard to set a key.

. When the Set Keys button turns red, it sets a key which appears on the time ruler. The
keys are color coded to reflect which tracks are being keyed.
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If you don't click Set Keys and you move to another point in time, the pose is lost.
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Tip To move the pose to another point in time, hold down the right mouse button while
dragging the time slider.

To animate a vertex using Set Key:

1. Create an editable spline.

m
2. Select a vertex.

[

3. Turn on ESAEE.

4. Move the selected vertex.

5. Click . (Set Keys).

Now a controller has been assigned to the vertex. From this point forward, you can animate.

To set a key on every keyable track of an object:

1. Select the object for which you need to set keys.

2. Turn on ESSEH.

3. On the Key Filters dialog, click All.

4. Click . (Set Keys) or press K on the keyboard.
Differences between Set Key and Auto Key modes:

Set Key mode differs from Auto Key in a number of ways.

In Auto Key mode, the workflow is to turn on Auto Key, move to a point in time, then
transform objects or change their parameters. All changes register as keyframes. When you turn
off Auto Key mode, you no longer are creating keys. Changes made to objects when Auto Key
mode is off are applied globally to the animation. This is referred to as Layout mode.

sasictll In Set Key mode, the workflow is similar, but the behavior is fundamentally different.
Turn on Set Key mode, then move to a point in time. Before you transform or change object
parameters, you determine the tracks you want to set keys on using Keyable icons in Track View
and Filters. Once you know what you plan to key, you try out poses in the viewport (transform
the objects, change parameters, and so forth).
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. When you like what you see, click the large Set Keys button or press K on the keyboard
to set a key. If you don't do this, no keys are set.

If you move to another point in time, your changes are lost and have no effect on your animation.
For example, if you find that you have a posed character, but at the wrong frame in time, you can
hold down Shift and the right-mouse button and drag the time slider to the correct frame without
losing your pose.

Path Constraint:

Assign Controller (object Position track) » Path Constraint

Standard menu: Animation menu » Position Controllers » Path Constraint

Use the Path constraint to restrict an object's movement along a spline or at an averaged distance
among multiple splines.

a—

Path constraint positions the service platform along the side of the bridge.

A path target can be any type of spline. The spline curve (target) defines a path of motion for the
constrained object. Targets can be animated using any of the standard translation, rotation, scale

tools. Setting keys at a sub-object level of the path, such as vertex or segment, animates the path

while affecting the constrained object.
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Procedure:

To assign a Path constraint:
1. Create a Sphere with a radius of 10 and a Circle with a radius of 60.

2. With the Sphere selected, choose Animation menu > Constraints » Path Constraint.

You are now in select target mode, as indicated by the rubber-band line attached to the
mouse Cursor.

3. Inthe viewport, click the Circle shape.

To access the Path constraint’s parameters through the Motion panel:

1. Select the Sphere.

2. Open the Motion panel.

3. Inthe PRS Parameters rollout, click the Position button.
The Path constraint's settings are located in the Path Parameters rollout.

Example: To assign a Path constraint through the Motion panel:

1. Create a Sphere with a radius of 10 and a Circle with a radius of 60.

2. Select the Sphere.

3. Goto the Motion panel and click Parameters.

>

Open the Assign Controller rollout and select the Position controller.

Click E (Assign Controller).
Choose Path Constraint from the Assign Position Controller dialog.
On the Motion panel, click Parameters.

In the Path Parameters rollout, click Add Path.

© © N o O

In the viewport, click the Circle.
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To edit weight values:

1. Onthe H Create panel, click B (Shapes), and create a Line that is about 120 units long.

TipUse the diameter of the Circle to gauge the length of the Line.

2. m Select the Sphere.

3. Onthe Motion panel, open the Path Parameters rollout.

4. Click the Add Path button, then click the line.
The Sphere is now affected equally by both paths since the path weighting defaults to 50

5. Adjust the Weight spinner or enter a numerical value for the weight value.

Example continued: To animate weight values:

1. Select the Sphere.

2. Onthe Motion panel, open the Path Parameters rollout.

. Turn on EEEESE (Auto Key).

3

4. Select Line01 from the Path list.

5. Drag the time slider to frame 50 and change the Weight of Line01 to 75.
6

Drag the time slider at frame 100 and change the Weight of Line01 to 10.

7. m Select the Circle01 path and change its Weighting to 25.
8. Turn off (Auto Key) and play the animation.

To correct path constrained object flipping:

When an object is assigned a path constraint and the follow box is turned on, the object will
rotate as it moves along the path. Sometimes the object is subject to unwanted flipping.
1. Select the object that is flipping.

2. On the Animation menu choose Constraints * Orientation constraint, then constrain the
object to another object's orientation.
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3. Use the control object to adjust the flipping. Animate the orientation of the control object,
while watching the flipped object at the problematic frames.

Interface Path Parameters rollout:

Once you assign a Path constraint, you can access its properties on the Motion
panel » Path Parameters rollout. On this rollout you can add or delete targets, assign weighting,
and animate each target's weight value.

Note: When you assign a Path constraint via the Animation menu, 3ds Max assigns a Position
List controller to your object. In the Position List rollout list you will find Path Constraint. This
is the actual path constraint controller. To view the Path Parameters rollout with the constraint
settings, double-click Path Constraint in the list.

| - Fath Parameters |

sddPath |
Delete Path |
— Target Weight —
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Add Path
Adds a new spline path that influences the constrained object.
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Delete path
Removes a path from the target list. Once removing the path target, it will no longer
influence the constrained object

[path list]
Shows the paths and their weights.

Weight
Assigns and animates weight values for each target.

Track View:

Graph Editors menu » New Track View

Main toolbar > (Curve Editor (Open))

Graph Editors menu » Track View - Curve Editor

Graph Editors menu » Track View - Dope Sheet

Graph Editors menu » Saved Track View » Choose a saved Track View.

Right-click the active viewport. » Quad menu » Transform quadrant » Curve Editor or Dope Sheet

Click or right-click the Point-Of-View (POV) viewport label. » POV viewport label menu » Extended Viewports > Track View >
Choose New or a saved Track View.

Track View provides two different graph-based editors for viewing and modifying animation
data in your scene. You can also use it to assign animation controllers to interpolate or control all
the keys and parameters for the objects in your scene.

Track View uses two different modes: Curve Editor and Dope Sheet. Curve Editor mode
displays animation as function curves, while Dope Sheet animation appears as a spreadsheet of
keys and ranges. Keys are color-coded for easy identification. Some Track View functions, such
as moving and deleting keys, are also available on the track bar near the time slider, which can
be expanded to show curves as well. The Curve Editor and Dope Sheet open by default as
floating windows, but you can also dock them under the viewports at the bottom of the interface,
or or even open them in a viewport. You can name Track View layouts and store them in a buffer
for later reuse. Track View layouts are stored with the MAX scene file.
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Track View - Curve Editor

Modes Controller Tracks Keys Curves Options Display View Utilities
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Track View — Dope Sheet (Edit Keys)

Track View can perform a variety of scene management and animation control tasks. Use Track
View to:

Display a list of objects in your scene and their parameters.
Change key values.

Change key timing.

Change controller ranges (see procedure).

Change interpolation between keys.

Edit ranges of multiple keys.

Edit blocks of time.

Add sound to your scene.

Create and manage notes about the scene.

Change the behavior of the animation outside the range of keys.

Change controllers for animated parameters

Select objects, vertices, and hierarchies.

Navigate the modifier stack in the Modify panel by clicking the modifier items in the Track

View Hierarchy.
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